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1
Introduction

The MA4000 Network Manager User Guide details the Network Manager 
application tool and enhancements to MA4000 Installation Manager that 
configures and manages Station Message Detail Recording (SMDR) and 
Fusion Networks for UNIVERGE SV7000 and NEAX IPX PBXs for version 
R22 and higher.

The following topics are included in this chapter:

Chapter Topics • MA4000 Network Manager Overview
• How This Guide is Organized
• MA4000 Network Manager Application Abbreviations

MA4000 Network Manager Overview

The MA4000 Network Manager is intended to enhance the capabilities 
already present within MA4000 Installation Manager. The Network 
Manager helps you manage your existing networks as you use 
Installation Manager to install and manage new networks

Though it adds functionality to MA4000 Installation Manager, the 
MA4000 Network Manager does not require MA4000 Installation 
Manager to perform its task. The MA4000 Network Manager is capable 
of running in a stand-alone mode to integrate SMDR and new PBX nodes 
into a Fusion (FCCS )network with a connecting node originally 
programmed using the MAT, the Installation Clipboard application, or 
MA4000 Installation Manager.

There are features/capabilities that must be added to an existing 
version of MA4000 Installation Manager in order to support FCCS 
networking. They are:

• Modify System Data (ASYD/L/N, AFMU, AIOC, and ALRTN)
• Modify Numbering Plan Data (ANDP, ANPDL, and ANPDN)
• Modify Station Data (ALGSL, ALGSN, and ASFC/N)
• Modify Route Data (ARTD/N and ARTI)

IMPORTANT

The MA4000 Network Manager enhancements do not require licensing separate of 
that included with MA4000 Installation Manager.
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• Modify SMDR Configuration Data (ASYD/L/N)
• Modify Service Feature Data (ASFC/N)

Table 1-1  Network Manager Features

How This Guide is Organized

Chapter 1
Introduction

This chapter outlines how to use this manual, including actual manual 
organization and chapter layout for the MA4000 Network Manager 
application.

Chapter 2
Getting Started

This chapter explains the hardware and software requirements of 
MA4000 Network Manager, and lists he steps needed to install the 
application.

Chapter 3
Graphical User Interface

This chapter provides an overview of the various interfaces of the 
MA4000 Network Manager software.

Chapter 4
Network Nodes

This chapter describes how MA4000 Network Manager gathers all SMDR 
and Fusion related data, as well as miscellaneous system data such as 
hardware type and software version.

Chapter 5
Network Settings

This chapter provides the information that MA4000 Network Manager 
uses to configure the NCN Switch network settings.

Chapter 6
Network Stations

This chapter explains how MA4000 Network Manager reads the 
Numbering Plan and station data from the NCN and LCN PBXs, then 
assigns the local stations from the PBX into the Fusion Network.

Chapter 7
SMDR Configuration

This chapter describes how MA4000 Network Manager configures SMDR 
for all nodes in the network, including routes and service features class 
in both the network and local data memories.

Function Description
NCN FCCS 

Synchronization
Gathers all SMDR and Fusion related data, as well as, 
miscellaneous system data such as hardware type and software 
version.

Insert LCN Node Programs both the NCN and LCN to establish the FCCS Fusion 
network connection.

NCN Network Settings 
Configuration

Configures the NCN PBX settings such as timer start, attendant 
FPC Console, etc.

NCN/LCN Station 
Integration

Gathers and integrates the Numbering Plan and Station data from 
both the NCN and LCN PBXs.

SMDR 
Configuration

Configures the SMDR for all nodes in the network including routes 
and service features class in both the network and local data 
memories.
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MA4000 Network Manager Application Abbreviations

CCIS Common Channel Inter-Office Signaling

DM Data Memory

DTI Digital Trunk Interface

FCH Fusion Call Handler

FCCS Fusion Call Control Handling

LCN Local Control Node

LDM Local Data Memory

NCN Network Control Node

NDM Network Data Memory

MAT Maintenance Administration Terminal

MC Media Converter

MG Media Gateway

SMDR Station Message Detail Recording

TCP/IP Transmission Control Protocol/Internet Protocol



1-4         Introduction

MA4000 Network Manager User Guide - Issue 1



   2-1

MA4000 Network Manager User Guide - Issue 1

2
Getting Started

This chapter lists the hardware and software requirements necessary to 
operate the MA4000 Network Manager. The chapter also provides the 
steps needed to install the MA4000 Network Manager.

Chapter Topics • Hardware and Software Requirements
• Installing MA4000 Network Manager

Hardware and Software Requirements

Table 2-1  System Requirements

NOTE

MA4000 Network Manager is installed as a tool when installing MA4000 Installation 
Manager. The installation steps listed in this chapter are for installing the MA4000 
Network Manager in the stand-alone mode.

Minimum Recommended
Operating System

Windows 98
Note:This is the bare minimum operating system.

Windows NT 4.0 (Service Pack 5 or later)
Windows 2000

(Service Pack 3 or later)
Window XP Professional
(Service Pack 1 or later)

Note:This is the preferred operation system.

Note: Other Windows operating systems may work, but will not be supported because of testing 
limitations. Users of Windows ME and Windows XP Home Edition will probably be able to 
successfully run MA4000 Installation Manager but these are not considered business operating 
systems.

Processor

Pentium 400 MHz Pentium 700 MHz

Memory

64 MB 128 MB, or more
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Hard Drive Space (available before installation)

250 MB 300 MB, or more

Monitor

800x600 SVGA 1024x768 SVGA

Web Browser (for support only)

Any HTML 1.1 compliant Internet Explorer 5.5, or greater

Ethernet Port

10/100 MB Ethernet Port for connecting to SV7000-T and SV7000S

Serial Port

For configuration of Peripheral Hardware (MC, MG, VS)

Modem

For SV7000-T software registration

PCMCIA Card Slot

Intel compatible PCMCIA card slot for use when initializing SV7000-T Flash Card

Database

Microsoft MSDE 2000 (Included on CD-ROM)

Additional Hardware

CD-ROM CD-ROM 2x, or higher

Mouse and 101 Keyboard Mouse and Keyboard

Minimum Recommended
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Installing MA4000 Network Manager

To install MA4000 Network Manager in a stand-alone mode, use the 
installation disc included in your MA4000 Installation Manager package. 
You must run Setup from within Windows.

The following procedure walks you through the MA4000 Network 
Manager installation. The setup consists of a series of dialogs supplying 
you with default answers to questions regarding the installation of files 
to your hard disk. To accept the default answers, click the Next button. 
To make changes, click the Browse button and select a different 
directory, then click the OK button to return to the dialog box.

The following procedure assumes you are starting the Setup program 
from your computer’s CD-ROM drive D:. If you start from a different 
drive, substitute the letter of that drive in this procedure.

Step  1 Launch Microsoft Windows 98, Windows 2000, or Windows XP 
Professional.

Step  2 Place the MA4000 Network Manager disc in the CD-ROM drive.

Step  3 Click the Windows Start button and select Run.... from the pop-up menu. 
The Run dialog box (Figure 2-1) displays.

Figure 2-1  Run

Step  4 Type D:\Setup in the Open text box (as shown in Figure 2-1) and click 
the OK button. The Network Manager R23 - InstallShield Wizard 
Welcome dialog box displays (Figure 2-2).

NOTE

Be sure to close all open Windows programs and screen savers. Plus, disable any 
virus detection programs before using the Setup program.
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Figure 2-2  Network Manager R23 - InstallShield Wizard Welcome

Step  5 Follow the prompts in the Setup program to accept the software licensing 
agreement, to enter your customer information, and to select the setup 
type. The Setup program copies the required files to your hard drive. 
 
The Network Manager R23 - InstallShield Wizard Completed dialog box 
displays (Figure 2-3) after the Setup program finishes copying files to 
your hard disk drive.
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Figure 2-3  Network Manager R23 - InstallShield Wizard Completed
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3
Graphical User Interface

This chapter provides an overview of the components of the MA4000 
Network Manager software.

The following topics are included in this chapter:

Chapter Topics • Startup Dialog
• Edit Menu
• Primary Sections

Startup Dialog

When MA4000 Network Manager is initially started, Figure 3-1 displays.

Figure 3-1  Initial MA4000 Network Manager Startup
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Pull-Down Menus

File Menu
The File pull-down menu (Figure 3-2) contains this function:

• Exit

Figure 3-2  File Menu

Edit Menu
The Edit pull-down menu (Figure 3-3) contains the common functions 
typically found in stand-alone applications.

Figure 3-3  Edit Menu

Cut (Ctrl+X)

Step  1 Select an item (this could be the context of a text box, or it could be 
multiple items in a list).

Step  2 After a selection is made, press the Ctrl and X keys to place the contents 
in the Windows Clipboard.

Step  3 You can now paste the contents to another location, such as another 
windows application, or to another location within MA4000 Network 
Manager. See Paste (Ctrl-V).

Paste (Ctrl-V)

Step  1 Place the curser in the field or in the row below where the contents of the 
Windows Clipboard is to be pasted. 

Step  2 If an item is selected, then the past operation will replace the selected 
item. In the case of a list box, the contents of the clipboard will be pasted 
above the cursor location. 

The contents of the clipboard must have the same number of columns as 
the destination list box. If it does not have exactly the same number of 
columns, the operation will not occur.
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Tools Menu
The Tools pull-down menu (Figure 3-4) contains the Flash Card 
Wizard, Registration Wizard, MAT, and Clipboard functions.

Figure 3-4  Tools Menu

Flash Card Wizard ...

The Flash Card Wizard option provides the tools to:

• Format and write new program files to a new flash card
• Upgrade the program files by reading program files to the personal 

computer and modifying the files using Explorer to write to the flash 
card, or backup data by reading data from the flash card to the 
personal computer. See Figure 3-5.   

To launch the Flash Card Wizard, do the following:

Step From the Network Manager Menu Bar, click Tools > Flash Card  
Wizard ....

WARNING

The Flash Card Wizard does not work on MPS due to MPS being Linux-based. See 
Registration Wizard ...  for procedure to upgrade the system.
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Figure 3-5  FLCVTR Initial 

• If the Initial Installation Execute button is clicked, Figure 3-6 
displays.

IMPORTANT

The flash card installation needs to be installed using the MPS System CD-ROM.



Graphical User Interface         3-5

MA4000 Network Manager User Guide - Issue 1

Figure 3-6  FLCVTR Initial Installation Execute 

Step  1 Insert an unformatted flash card into an available PCMCIA slot. Ensure 
you insert a flash card prior to launching the FLCVTR program in order to 
display the PC’s PCMCIA slot for the Flash Card field.

Step  2 Click the Browse button to locate the file containing the program to be 
written to the flash card.

Step  3 Select the PCMCIA slot for the flash card.

Step  4 Click the Set button to write the program to the flash card.

Step  5 After pressing the Set button, Figure 3-7 displays.

NOTE

If defining the partition size is necessary, select the appropriate size from the pull-
down menu located in the Partition Size (MB) field. Normally, the Partition Size 
(MB) field is not visible, choose the Option menu item and select the PartitionSize 
Select option to make the field visible.
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Figure 3-7  Setting INITDATA 

Step  6  Enter the IP Address, Subnet Mask and Gateway of the SV7000, then 
click the Set button.

NOTE

This option only applied to the UNIVERGE SV7000, and is not available for a NEAX 
2400 IPX.
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• If the Program Upgrade Execute button is clicked, Figure 3-8 
displays.

Figure 3-8  FLCVTR Program Upgrade Execute 

Step  1 Insert the flash card containing the program files into an available 
PCMCIA slot.

Step  2 In the Drive field, choose the drive containing the program files and the 
location where the files are to be written.

Step  3 Select the PCMCIA slot for the flash card.

Step  4 Click the Browse button to locate the folder or CD Drive where the 
Program Files are located. 

Step  5 Click the Set button to load the Program Files to the Flash Card.

TIP

If the Drive field is not visible, choose the Option menu item and select the Drive 
Select option.
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• If the Data Backup Execute button is clicked, Figure 3-9 displays.

Figure 3-9  FLCVTR Data Backup Execute 

Step  1 Insert the flash card containing the program files into an available 
PCMCIA slot.

Step  2 In the Drive field, choose the drive containing the office data files and the 
location where the files are to be written.

Step  3 Select the PCMCIA slot for the flash card.

Step  4 Click the Browse button to locate the folder where the office data files 
will be written.

Step  5 Click the Get button to write the office data files located on the flash card 
to the location selected.

TIP

If the Drive field is not visible, choose the Option menu item and select the Drive 
Select option.
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Registration Wizard ...
The Registration Wizard connects your system to the NEC 
Registration Service and obtains your Activation Code. See Figure 3-10.

To launch the Registration Wizard, do the following:

Step From the Network Manager Menu Bar, click Tools > Registration  
Wizard ....

Figure 3-10  Welcome to the Registration Wizard 

Step  1 Select the Next button to proceed. Figure 3-11 displays.
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Figure 3-11  NEC Registration Wizard - We Want To Know About You 

Step  2 Select the Next button to continue. Figure 3-12 displays.
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Figure 3-12  NEC Registration Wizard - Site Information 

Step  3 Enter the site information requested. Those fields denoted with an 
asterisk require an entry.

Step  4 Click the Next button to continue. Figure 3-13 displays.
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Figure 3-13  NEC Registration Wizard - Complete Your NEC Registration 

Step  5 Click the Next button. Figure 3-14 displays.
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Figure 3-14  NEC Registration Wizard - Select System to Activate 

Step  6 Select the appropriate system from the list provided.

—Direct Connection to the System. Enter the communication port and 
baud rate. 

— IP Connection to the System. Enter the IP address.
—Modem Connection to the System. Select the modem type, enter 

the dialing number, and create, edit or retrieve a connection profile. 
Click the Save Connection button to save the modem profile.

Step  7 Click the Next button. Figure 3-15 displays.
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Figure 3-15  NEC Registration Wizard - Gather Security Codes from System 

Step  8 Click the Get System Information button to connect your system and 
obtain/update the hardware and software key codes. 

Step  9 Click the Next button to proceed. Figure 3-16 displays.
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Figure 3-16  NEC Registration Wizard - Registration Information 

Step  10 In the Modem Configuration Section, enter or select the correct 
information into the Modem Name and Registration Server Dialing 
Number fields.

Step  11 Click Connect to NEC Registration Server and obtain the Activation 
Code.

—The modem defined in Step 10 calls into the server and retrieves the 
Activation Code, or you can select the By TCP-IP option button to 
connect using that method.

—The activation code will display in Activation Code field after 
successful registration with the NEC Registration Service.

Step  12 Select the Next button. Figure 3-17 displays.
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Figure 3-17  NEC Registration Wizard - Activate Your System 

Step  13 To activate your system, click the Next button. Figure 3-18 displays.
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Figure 3-18  NEC Registration Wizard - System Activation

Step  14 Select the Send Activation License button to activate your system. 

Step  15 Select the Next button to proceed. Figure 3-19 displays.

NOTE

If the Activation License field is empty, you can either go back and connect to the 
NEC Registration Server or temporarily activate your system with the Unlock button.
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Figure 3-19  NEC Registration Wizard - Congratulations 

Step  16 Click the Finish button to exit the Registration Wizard.

MAT ...
The Maintenance Administration Tool (MAT) is a command-line interface 
application for configuring your system. Experienced users who wish to 
use the MAT to send commands directly to the switch can launch it from 
within Network Manager.

To launch the MAT, do the following:

Step  1 Launch the Network Manager. The Startup dialog displays.

Step  2 Select an existing project or create a new project. The Network Manager 
main screen displays.

Step  3 Select Tools > MAT.... The MAT launches and displays as a separate 
application.
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Clipboard...
Network Manager now provides experienced users with integrated 
access to the MAT Clipboard application. You can use this tool to access 
MAT commands and transfer information directly to the Voice Server or 
work offline and upload all changes at once.

The Clipboard can save command data from the Voice Server as XML 
(Extensible Markup Language) files. You can then edit the XML files 
using Microsoft Excel and upload the modified data back to the Voice 
Server. Many MAT commands are time-consuming when programmed 
individually. Using the Clipboard to download and upload the command 
data in a single operation can make many tasks more efficient. For 
example:

• Create an off-line XML file containing a large number of new users, 
configured using the ASDT and AKYD commands, then upload the file 
to the Voice Server.

• Transfer data from an old Voice Server to a new Voice Server by 
downloading user data, editing it off-line, then uploading it to the new 
Voice Server.

The Clipboard application (Figure 3-20) speeds system installations and 
eliminates errors by importing data from one switch to a destination 
switch. 

Clipboard has been enhanced to be able to perform batch downloads. 
You have the ability to:

• Download data from the switch based on categories (for example, 
Station Data, Trunk Data, Restricted Data, etc.)

• Add commands the data needs to be download to a list that would be 
run as a batch process.

• Save selected commands in user template files for future access. 

This enhancement lessens the work needed when downloading data for 
the same set of commands.

 
To launch Clipboard, do the following:

Step From the Network Manager Menu Bar, click Tools > Clipboard.

Figure 3-20  MAT Clipboard

REFERENCE

For more complete information on using the Clipboard, refer to its user 
documentation.



3-20         Graphical User Interface

MA4000 Network Manager User Guide - Issue 1

Help Menu
The Help pull-down menu is the place to go for assistance or 
information.

About MA4000 Network Manager …
The About MA4000 Network Manager... option displays the 
application’s version and copyright information (Figure 3-21).

Figure 3-21  About MA4000 Network Manager 

View Log File …
The View Log File... option lists the current MA4000 Network Manager 
log build information. 
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Primary Sections

The tabs located along the left side of the graphical user interface in the 
Main window (see Figure 3-22) contain the core functions of MA4000 
Network Manager. This is where you will view, manipulate, and prepare 
the data to be sent to the system.

Figure 3-22  Primary Section Tabs

When a tab is selected, a view displays for each. This information is a 
logical break down of the tab.

The following chapter describes in detail every tab and its purpose.
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4
Network Nodes

This chapter describes the MA4000 Network Manager’s Network Node 
tab.

Chapter Topics • Network Nodes Overview
• Creating a PBX Alias
• Inserting LCN Node
• Using an Existing PBX Alias

Network Nodes Overview

The Network Nodes tab is used, after Network Manager is connected 
to a PBX, to gather all SMDR and Fusion related data, as well as 
miscellaneous system data such as hardware type and software version.

Figure 4-1  MA4000 Network Manager - Network Nodes Tab
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Creating a PBX Alias

To create a new PBX Alias, do the following:

Step  1 Select the Browse button located immediately to the right of the PBX 
Alias drop-down field. Figure 4-2 displays.

Figure 4-2  PBX Administration - New PBX Alias

Step  2 Enter the desired information in the fields described in Table 4-1.

Table 4-1  PBX Administration Field Descriptions

Field Description
PBX Alias Select an existing, or create a new alias name for the PBX.

Connection Type Specify the communication interface used to connect to the system. 
The choices are:
• Serial/Direct (not supported)
• TCP/P

FUG Fusion Group Group Number. Used by the AFUGN command (and 
others). Used when you have two groups of PBXs in two different 
Fusion Networks. Allows you to have a Centralized MAT to access 
both networks. 

FPC Fusion Point Code (LCN Only). If the system is to be a LCN in a 
Fusion Network, select an appropriate Fusion Point Code.

Serial Settings - COM Port — not supported —

Serial Settings - Baud Rate — not supported —

TCP/IP Setting - Host Name Enter the name of the SV7000 T10 or IPX.

TCP/IP Setting - IP Address Enter the IP address of the SV7000 T10 or IPX.

TCP/IP Setting - TCP Port Enter 60000.
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Inserting LCN Node

The following procedure inserts a new LCN PBX into an existing Fusion 
Network. The LCN Fusion Point Code should not match any Fusion Point 
Code of an existing switch in the fusion network.

The memory version of the PBX software must match all the existing 
switches in the fusion network. Currently, only TCP/IP Connection PBX’s 
can be added into a Fusion network.

Step  1 In Figure 4-1, click the Add Node button. Figure 4-3 displays.

Figure 4-3  Network Connection Type

Step  2 Select the Peer-to-Peer (F2P) option button and click the Next button. 
Figure 4-4 displays.

NOTE

At this time, only the TCP/IP Connection PBX’s can be added to a Fusion network.
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Figure 4-4  PBX Nodes

Step  3 Select the NCN PBX and the new LCN PBX nodes to be added to the 
fusion network.

—Node A is the Network Control Node (NCN) PBX of the fusion 
network, and should always be a NCN PBX.

—Node B is the LCN PBX that will be added to the fusion network.

Step  4 After selecting the Node B to be inserted into the fusion, enter the 
Fusion Point Code (FPC) of the node, then click the Next button.  
Figure 4-5 displays the Node A Configuration (NCN).

WARNING

Restriction: The PBX software revisions should match for all the nodes in the fusion 
network. The FPC should be greater than 0 and less than 253. All the PBX’s in the 
fusion network should have different FPC’s.
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Figure 4-5  Node Information - NCN PBX

Step  5 Click the Next button programs the Node A (NCN) with the Node B 
information, assigning the FCCS data to the NCN. Figure 4-6 displays 
the Node B configuration with the newly added LCN PBX node 
information.
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Figure 4-6  Node Information - LCN PBX

Step  6 Click the Next button to program the Node B and assign Node B to the 
fusion network, assigning the FCCS data to the LCN. Figure 4-7 
displays.
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Figure 4-7  Insert Network Node

Step  7 Click the Finish button to complete the node insertion. You may need to 
perform the following to complete the installation process:

—Backup databases and reset the PBX’s
—Initialize the Fusion Network using the CBCN MAT command.

After the installation is finished, the network nodes (Figure 4-8) refresh 
displaying the newly added LCN in the fusion network.

The MAT commands are issued to both the NCN and LCN PBXs in order 
to insert the new mode into the existing network (AFIPN, AFRIL). All the 
LCN PBXs should have the same memory version as the NCN PBX.

After a new PBX mode is successfully integrated in the Fusion network, 
it will display on the Node list view control on the Network Nodes tab.
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Figure 4-8  Network Nodes  - LCN Fusion Network Example
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Using an Existing PBX Alias

To use an existing PBX Alias, do the following:

Step  1 Select a specific PBX from the PBX Alias drop-down field. See  
Figure 4-9. 

Figure 4-9  Network Nodes - PBX Alias

Step  2 Click the Login button.

—The PBX selected should be a NCN (Network Control Node) switch.
—Figure 4-10 displays indicating that the network configuration is being 

read. Click the Cancel button to abort the process.
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Figure 4-10  Network Manager - Reading Network Configuration

—If the PBX is password-protected, Figure 4-11 displays prompting the 
user to enter the appropriate user identification and password.
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Figure 4-11  Network Manager - PBX Login

Step  3 Enter the user’s name and password. The application reads the network 
information and displays the current Fusion network (see Figure 4-12).
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Figure 4-12  Network Manager - Current Fusion Network
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5
Network Settings

This chapter describes the MA4000 Network Manager’s Network 
Settings tab.

Chapter Topic • Network Settings Overview
• Configuring NDM Settings

Network Settings Overview

The Network Settings tab is used to configure the NCN Switch 
network settings displayed in Figure 5-1 and described in Table 5-1. The 
changes affect the NCN PBX only. The Network Settings tab contains 
complete information about the Fusion node selected previously, and 
lets you configure certain Network Data Memory (NDM) settings.

Figure 5-1  MA4000 Network Manager - Network Settings Tab
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Table 5-1  Network Settings Field Descriptions

Field Description
ACDP Denotes the ACD (Automatic Call Distribution) version of the PBX 

software.
Attendant Console FPC Denotes the FPC (Fusion Point Code) of the node providing the 

Attendant Console.
Auto Data Copy If not checked, Data Broadcasting is performed at every NDM 

(Network Data Memory) command. 

If checked, Data broadcasting is performed by the CBCN 
Command. This option is enabled only on the IPX-UMG.

Boot ROM Denotes the Boot ROM version of the PBX software.

Broadcast Retry If not checked, stops NDM Broadcasting to LCN’s from NCN’s. 

If checked, starts NDM broadcasting to LCN’s from NCN’s.
Dial Pulse Relay If checked, Conference over Fusion Call and DP Pulse Relay over 

FCCS is valid, otherwise it is invalid.
Format ID Denotes the identification of the Command Format supported by the 

PBX software.
FPC Denotes the PBX Fusion Point Code.

Gateway The Gateway address for routing.

IP Address The Internet Protocol address for the equipment.

Main Memory Denotes the Main Memory version of the PBX Software.

MAT Version Denotes the MAT version of the PBX Software.

NDM Broadcast by MP If checked, Data Broadcasting is performed by the SP Processor 
when assigning NDM commands. 

If not checked, Data broadcasting is performed by the MP 
Processor when assigning NDM Commands. This option is enabled 
only on IPX-UMG.

NDM Individual Broadcast If checked, NDM Data would be broadcasted to the individual LCN.

If not checked, NDM Data would be broadcasted to ALL the LCN’s. 
NDM Memory Blocks Denotes the number of Network Data Memory Blocks allocated.  

This option is grayed out.  It only displays the number of blocks 
allocated; no changes can be done via Network Manager. 

NDM Refresh If checked, the System message for error during “periodic refresh” 
is valid, otherwise it is invalid. This option is enabled only on IPX-
UMG.

Network Mask A string of 0’s and 1’s that mask or screen out the network part of an 
IP address (IP) so that only the host computer part of the address 
remains.

Office Data Startup if checked, System Message Output is in service, otherwise it is out 
of service. This option is enabled only on IPX-UMG.

Office Name Denotes the PBX office name. The office name is set by the AOFC 
Command.
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Configuring NDM Settings

To view  network information and to specify NDM options about a 
selected node, do the following:

Step  1 From within Network Manager, click the Network Nodes tab.

Step  2 Use the PBX Alias dropdown menu to select a PBX from a list of existing 
nodes on your network. This PBX should be a Network Control Node 
(NCN).

Step  3 Click Login. A progress dialog displays while Network Manager retrieves 
your network configuration information. 
 
(Optional) If the PBX is password protected, a login dialog displays. 
Enter your User ID and Password in the appropriate fields, then click 
Login.

Step  4 Click the Network Settings tab to display it. Current information about 
the selected nodes displays (see Table 5-1).

Step  5 Use the NDM Memory Blocks dropdown menu to specify the number of 
Network Data Memory Blocks the selected node uses. (UMG or IPX 
systems only.)

Step  6 Use the Starting Timer dropdown menu to specify.

Step  7 Use the Attendant Console FPC dropdown menu to specify the Fusion 
Point Code of the PBX that contains the attendant console.

Step  8 Use the checkboxes to enable or disable the options (see Table 5-1).

Step  9 Click Apply to save your changes.

Selective Routing Denotes the FCCS Control information for Selective routing.

If checked, takes the primary route specified by AFPC/AETH 
command. 

If not checked, takes the route which the last signal packet sent out. 
Standby IP Denotes the IP Address of the standby CPU (applicable in the case 

of a dual cpu).
Starting Timer Options for choosing the Timing start key.  By dialing the station 

followed by the timing start key, the station user will not have to wait 
for ring start. 

System Type Denotes the PBX System type (UNIVERGE SV7000, NEAX IPX, 
NEAX IPX-UMG).

Timing Start If checked, timing start service is enabled. 

If not checked, timing start service is disabled.  

Field Description



5-4         Network Settings

MA4000 Network Manager User Guide - Issue 1



   6-1

MA4000 Network Manager User Guide - Issue 1

6
Network Stations

This chapter describes the MA4000 Network Manager’s Network 
Stations tab.

Chapter Topic • Network Stations Overview
• Assigning Network Stations
• Editing a Network Station
• Deleting a Network Station

Network Stations Overview

The Network Stations tab (Figure 6-1) reads the Numbering Plan and 
station data from the NCN and LCN PBXs, then assigns the local stations 
from the PBX into the Fusion Network.

Figure 6-1  MA4000 Network Manager - Network Stations Tab
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Assigning Network Stations

The Network Stations tab contains a list of all the Fusion networks 
physical stations, their station numbers, and their corresponding 
network station number, if any. 

To assign a local station to a Fusion network, do the following:

Step  1 From within Network Manager, click the Network Stations tab to select 
it. A list of existing physical stations and their network assignments, if 
any, displays.

Step  2 Click Assign. Figure 6-2 displays.

Figure 6-2  Select PBX Node

Step  3 Use the Select PBX Node dropdown menu to select the PBX containing 
the physical station you wish to assign to the Fusion network, then click 
OK. Figure 6-3 displays a list of the PBX's configured stations.
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Figure 6-3  Local PBX Stations

Step  4 Use the Station Mapping Mode dropdown menu (Figure 6-4) to specify 
how the physical station's number will be mapped to the Fusion network. 
The available options are:

—None <TELN = STN>
—Prefix Digit(s) <TELN = 'xx' + STN>
—Prefix Digit(s) <TELN = 'xx' minus 1st digit of STN>
—Prefix Digit(s) <TELN = 'xx' minus 1st two digits of STN>
—Prefix Digit(s) <TELN = 'xx' minus 1st three digits of STN>
—User Defined
—Best Fit <Merge Stations> 
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Figure 6-4  Local to Network Station Mapping

Step  5 (Optional) If you selected any of the Prefix Digit(s) options in the previous 
step, the Select Network Telephone P... dialog displays (Figure 6-5). 
Enter the digits you wish added as a prefix to the STN number, then click 
OK.

Figure 6-5  Prefixed Network Telephone Number Digits

Example: Consider LCN Station number 5432 and the digits to be prefixed are 
66. 
 
TELN = ‘xx’ + STN  e.g. TELN = 66 + 5432 = 665432 
 
TELN = ‘xx” minus 1’st digit of STN  e.g. TELN = 66 - (5)432 = 66432 
 
TELN = ‘xx’ minus 1’st two digits of STN  e.g. TELN = 66 - (54)32 = 
6632 
 
TELN = ‘xx’ minus 1’st three digits of STN  e.g. TELN = 66 - (543)2 = 
662

NOTE

The Best Fit < Merge Stations > option selects stations from an existing numbering 
plan scheme.
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Step  6 Click a station in the list you wish to assign to the Fusion network, then 
click Edit. Figure 6-6 displays.

Figure 6-6  Edit Network Number

Step  7 Enter the station's new Fusion station number in the Network Number 
field, then click OK. The list of network station numbers updates with the 
new number.

Step  8 Check the status panes at the bottom of the Assign Network TELN 
(ALGSN) dialog (Figure 6-3) to determine whether there are any conflicts 
with existing network numbers. See Table 6-1.

Table 6-1  Status Panes Descriptions

Step  9 (Optional) Select one or more stations, then click Delete to remove the 
station(s) from the Assign Network TELN (ALGSN) dialog. 

Step  10 Click Apply to save the station's network number.

Color Description
The number of "collisions" or conflicts with existing network 
numbers.

How many new stations were created.

The number of existing network stations.

The number of stations that have been edited or changed.

NOTE

This does not delete the station itself but merely removes it from the list in the dialog 
box. This technique can help you simplify a large list when looking for conflicts, 
available numbers, etc.
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Editing a Network Station

To change an existing network station's Fusion network number, do the 
following:

Step  1 From within Network Manager, click the Network Stations tab to select 
it. A list of existing physical stations and their network assignments, if 
any, displays (see Figure 6-3).

Step  2 Select the station whose network number you wish to change, then click 
Edit. The Network Number dialog displays (see Figure 6-6).

Step  3 Enter the new number in the Network Number field.

Step  4 Click Apply to save the new network number.

Deleting a Network Station

To remove an existing network station from the Fusion network, do the 
following:

Step  1 From within Network Manager, click the Network Stations tab to select 
it. A list of existing physical stations and their network assignments, if 
any, displays (see Figure 6-3).

Step  2 Select the station whose network number you wish to remove, then click 
Delete. A confirmation dialog displays.

Step  3 Click Yes to remove the network station.
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7
SMDR Configuration

This chapter describes the MA4000 Network Manager’s SMDR 
Configuration tab.

Network Manager lets you specify whether you wish to enable Station 
Message Detail Recording (SMDR) on a route, node, or feature basis. 
Network Manager only administers a pure Fusion (FCCS) network. If 
your network contains a mixture of Fusion and CCIS nodes, you must 
configure SMDR manually using the MAT.

The SMDR Configuration tab contains lists of the available network 
nodes, network routes, and network features in your Fusion network. If 
no entries display in the lists, you must first select a node to manage 
and login to the NCN.

Chapter Topic • SMDR Configuration Tab
• Configuration Tab
• Alarm Tab
• Routes Tab
• Features Tab
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SMDR Configuration Tab

The SMDR Configuration tab (Figure 7-1) configures SMDR for all 
nodes in the network, including routes and service features class in both 
the network and local data memories. The panel is for FCCS SMDR only.

Figure 7-1  MA4000 Network Manager - SMDR Configuration Tab

To configure the local SMDR System and route and service features 
settings do the following:

Step  1 Select the node in the Network Nodes section (see Figure 7-1) for the 
SMDR that needs to be configured, then click the Edit button. Figure 7-2 
displays and the dialog box tabs are described in Table 7-1.
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Figure 7-2  Edit SMDR Configuration

Table 7-1  SMDR Configuration Tab Descriptions 

Tab Description
Configuration Configures the basic SMDR settings.

Alarms Configures the alarms.

Routes Configures the SMDR Route settings.

Features Configures the SMDR Feature class settings.
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Configuration Tab

The Configuration tab (Figure 7-2) lists the basic SMDR setting. 
MA4000 Network Manager uses this tab to configure the basic settings, 
such as SMDR Type (Center, Polled or Local), SMDR Output Type (RS-
232 / TCP/IP), Output Format (IMX, ICS Extended or Normal), etc.

Table 7-2  Configuration Tab Field Descriptions

Field Description
SMDR Type Select a SMDR node type to provide the user with options specific 

to that node in order to configure them. The SMDR node types are: 

• Local SMDR
• Center FCCS Node
• Polled FCCS Node

Nodes Polled At Once Denotes the number of nodes to poll. This option displays only for 
the Center FCCS SMDR type.

Output Type The output types are: 

• RS-232
• TCP/IP
This option is enabled for Local and Center FCCS SMDR nodes 
only. To change the output format of a Polled FCCS node, change 
the SMDR type of Polled FCCS Node to Center. Change the output 
format and then revert the SMDR Type back to Polled FCCS node.

Output Format The output formats are:

• IMX
• ICS Extended
• Normal Format
This option is enabled for the Local and Center FCCS SMDR types 
only.

Parity Check for TCP/IP This option is enabled only when the output type is TCP/IP.

Device A
Device B
Device C
Device D

RS-232 Output Type: Devices identify the I/O output port number 
for SMDR each device, respectivley.

TCP/IP Output Type: Devices denote whether each of the devices 
need to be turned ON or OFF.

SMDR Data Collection Collects the information indicating what is, or is not,  to be recorded. 
Information collected is:

• SMDR Billing Party Information for Transfer to Call Forward
• Billing Type
• Outgoing Billing Information
• Record Physical Station or Logical TELN
• Record Physical Route or Logical Route
• Length of Authorization Code in SMDR
• Record Number Dialed or Number Sent on SMDR
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Notes
• There can only be the Center FCCS Node in the fusion network.
• All the polled and center SMDR types should have the same output 

type (TCP/IP or RS-232).
• RS-232 is not supported on the UNIVERGE SV7000.
• MCI and SMDR should have the same Output types no matter what 

SMDR node type selected.
• For the RS-232 Output type, it must match the data assignment in the 

AIOC Command.
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Alarm Tab

MA4000 Network Manager uses the Alarms tab (Figure 7-3) to configure 
the basic alarm settings.

Configuring SMDR Alarms
To set SMDR alarm timers for a specific node, do the following:

Step  1 Click the SMDR Configuration tab to select it. A list of available network 
nodes displays. If no entries display in the list, you must first select a 
node to manage and login to the NCN.

Step  2 Select the network node for which you wish to enable SMDR, then click 
Edit. The Edit SMDR Configuration dialog displays, containing four sub-
tabs.

Step  3 Click the Alarms sub-tab. Figure 7-3 displays.

Figure 7-3  Edit SMDR Configuration - Alarms Tab

Step  4 Use the dropdown menus to specify a value (in seconds) for the timers. 
See Table 7-3.
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Table 7-3  SMDR Timer Values

Step  5 (Optional) Click the Notify On SMDR Buffer Overflow checkbox to 
enable the alarm. Then use the dropdown menus to specify a value (in 
percentages) for the timers. See Table 7-4.

Table 7-4  Notify On Hold SMDR Buffer Overflow Timer Values

Step  6 (For RS-232 SMDR Output Type only) Use the dropdown menus to 
specify a value (in minutes) for the SMDR Output Port Failure Alarm 
Timer for Devices A-D. The device timers are enabled only if the 
corresponding port is active.

Step  7 Click Apply to save the new alarm timer settings.

Timer Range of Values (sec.) Default Value (sec.)
Trunk Soft Hold Timer A 0-30 seconds, in 2-second 

intervals
30

Trunk Soft Hold Timer B 0-30 seconds, in 2-second 
intervals

18

Timer for transmitting billing data 2-14 seconds, in 2-second 
intervals

8

Timer Range of Values (pct) Default Value (pct)
Clear Alarm At 30, 40, 50, 60, 70, 80 50

Send Alarm At 60, 70, 80, 90, 95, 99 80

Upper limit of Polling Buffer rate
Note: Enabled on Center FCCS 

Node only.

1 to 99% in 1% intervals 50

NOTE

The SMDR Output Port Failure Alarm Timer option is only enabled when the output 
type of the SMDR is RS-232. Additionally, each device option -- A, B, C and D -- are 
only enabled when the device output ports are active.
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Routes Tab

Configuring SMDR for Routes (Per Node)
To enable SMDR on one or more of a node's configured routes, do the 
following:

Step  1 Click the SMDR Configuration tab (Figure 7-1) to select it. A list of 
available network nodes displays. If no entries display in the list, you 
must first select a node to manage and login to the NCN.

Step  2 Select the network node for which you wish to enable SMDR on a route, 
then click Edit. The Edit SMDR Configuration dialog displays, containing 
four sub-tabs.

Step  3 Click the Routes sub-tab. Figure 7-4 displays. A list of existing routes 
displays.

Figure 7-4  Edit SMDR Configuration - Route Tab

Step  4 Click the route for which you wish to enable SMDR, then click Edit. The 
Edit SMDR Route Settings (ARTD) dialog displays. See Figure 7-5.
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Figure 7-5  Edit SMDR Route Settings (ARTD)

Step  5 Click the Enable SMDR checkbox.

Step  6 (Optional) Use the appropriate checkbox to specify whether SMDR 
should create an incoming and outgoing tandem record, as follows:

—Do Not Create Outgoing Tandem Record (CDN56 - SMDR3)
—Do Not Create Incoming Tandem Record (CDN69 - SMDR4)

Step  7 Use the Billing Information (CDN10 - SMDR2) dropdown menu to 
specify the type of incoming and outgoing calls that will create a billing 
record.

Step  8 Use the SMDR Called Party Number will show (CDN121 - CONV) 
dropdown menu to the number dialed or the number sent.

Step  9 Click Apply to save the SMDR options for the selected route.

Step  10 (Optional) Repeat the previous steps to configure any additional routes 
for the selected node.



7-10         SMDR Configuration

MA4000 Network Manager User Guide - Issue 1

Configuring SMDR for Network Routes
To enable SMDR for one or more of a the Fusion network's available 
routes, do the following:

Step  1 Click the SMDR Configuration tab (Figure 7-1) to select it. A list of 
available network nodes displays. If no entries display in the list, you 
must first select a node to manage and login to the NCN. 

Step  2 From the Network Routes (ARTDN) list, select the network route for 
which you wish to enable SMDR, then click Edit. Figure 7-6 displays.

Figure 7-6  Edit SMDR Network Route Settings (ARTDN)

Step  3 Click the Enable SMDR checkbox.

Step  4 (Optional) Use the appropriate checkbox to specify whether SMDR 
should create an incoming and outgoing tandem record, as follows:

—Do Not Create Outgoing Tandem Record (CDN56 - SMDR3)
—Do Not Create Incoming Tandem Record (CDN69 - SMDR4)

Step  5 Use the Billing Information (CDN10 - SMDR2) dropdown menu to 
specify the type of incoming and outgoing calls that will create a billing 
record.

Step  6 Use the SMDR Called Party Number will show (CDN121 - CONV) 
dropdown menu to the number dialed or the number sent.

Step  7 Click Apply to save the SMDR options for the selected route
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Features Tab

Configuring SMDR for Features (Per Node)
To enable SMDR for one or more of a node's configured features, do the 
following:

Step  1 Click the SMDR Configuration tab (Figure 7-1) to select it. A list of 
available network nodes displays. If no entries display in the list, you 
must first select a node to manage and login to the NCN.

Step  2 In the Network Nodes list, select the node for which you wish to enable 
SMDR for a Service Feature Class (SFC), then click Edit. The Edit 
SMDR Configuration dialog displays, containing four sub-tabs.

Step  3 Click the Features sub-tab. Figure 7-7 displays.

Figure 7-7  Edit SMDR Configuration - Features Tab

Step  4 Click the feature class for which you wish to enable SMDR, then click 
Edit. Figure 7-8 displays.
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Figure 7-8  Edit SMDR Feature Settings (ASFC)

Step  5 Select the Day or Night tab, as needed, to specify SMDR for a feature 
during Day or Night mode.

Step  6 Use checkboxes to enable or disable SMDR for the following features:

—SFI 14: Basic Trunk SMDR
—SFI 58: Station to Station SMDR
—SFI 219: Station to Station via IP SMDR

Step  7 Click Apply to save the SMDR feature settings for the selected node.
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Configuring SMDR for Network Features
To enable SMDR for one or more of a node's configured features, do the 
following:

Step  1 Click the SMDR Configuration tab (Figure 7-1) to select it. A list of 
available network nodes displays. If no entries display in the list, you 
must first select a node to manage and login to the NCN.

Step  2 From the Network Features (ASFCN) list, select the network feature for 
which you wish to enable SMDR, then click Edit. The Edit SMDR 
Network Feature Settings (ASFCN) dialog displays containing four sub-
tabs.

Step  3 Click the Features sub-tab. Figure 7-9 displays.

Figure 7-9  Edit SMDR Configuration - Features Tab

Step  4 Click the feature class for which you wish to enable SMDR, then click 
Edit. Figure 7-10 displays.
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Figure 7-10  Edit SMDR Network Feature Settings (ASFCN)

Step  5 Select the Day or Night tab, as needed, to specify SMDR for a feature 
during Day or Night mode.

—SFI 14: Basic Trunk SMDR
—SFI 58: Station to Station SMDR
—SFI 219: Station to Station via IP SMDR

Step  6 Click Apply to save the SMDR network feature settings.



For additional information or support on this NEC Unified Solutions 
product, contact your NEC Unified Solutions representative.
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